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Page 3: Preface
Preface Thank you for purchasing TOSHIBA Multifunctional Digital Systems. Also this guide
describes instructions on how to set up the printer drivers required for this equipment, and how
to print with them. Read this manual before using your Multifunctional Digital Systems. Keep
this manual within easy reach, and use it to configure an environment that makes best use of
the e-STUDIO’s functions.

Page 4 IBM, AT and AIX are trademarks of International Business Machines Corporation.
NOVELL, NetWare, and NDS are trademarks of Novell, Inc. TopAccess is a trademark of Toshiba
Tec Corporation. Other company and product names given in this manual or displayed in this
software may be the trademarks of their respective companies.

Page 5: End User Software License Agreement
SOFTWARE TO THE LOCATION WHERE YOU OBTAINED IT. Grant of License: This is a legal
agreement between you, the end-user (“You”), and TOSHIBA TEC Corporation (“TTEC”). This
software, fonts (including their typefaces) and related documentation (“Software”) is licensed
for use with the system CPU on which it was installed (“System”) in accordance with the terms
contained in this Agreement.

Page 7: Table Of Contents
CONTENTS Preface............................1 End User Software License Agreement ................. 3
Chapter 1 OVERVIEW Features and Functions ......................8 About Printer Drivers
....................... 9 For Macintosh........................9 For UNIX/Linux ........................9 Chapter 2
PRINTING FROM WINDOWS Before Using the Printer Driver..................... 12 Configuring the
options......................

Page 8 Chapter 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Monitoring the Print Job
Status ..................178 Normal Print / Scheduled Print jobs................... 178 Proof Print jobs
........................183 Private Print jobs ....................... 186 Hold Print jobs ........................190
Invalid jobs ........................194 Printing files from USB media (USB Direct Printing) ............

Page 9: Overview
OVERVIEW This chapter provides an overview of the printing functions. Features and
Functions......................8 About Printer Drivers ....................... 9 For
Macintosh.................................9 For UNIX/Linux ...............................9...

Page 10: Features And Functions
1 OVERVIEW Features and Functions Extensive Client Platform Support This equipment supports
printing from IBM-compatible PC, Macintosh, and UNIX/Linux workstations. Not all features are
supported on all platforms, however. Various Port Options You can map this equipment to print
to an SMB, IPP, Raw TCP, WSD, or LPR port. Multiple Job Types Job Types refer to the way this
equipment handles a print job.

Page 11: About Printer Drivers
1 OVERVIEW About Printer Drivers Printer drivers required for each OS are included in the Client
Utilities CD-ROM. For instructions on how to install them, refer to the Software Installation
Guide. For Macintosh Printer drivers required for Macintosh OSs are included in the following
folders of the Client Utilities CD-ROM: Macintosh PPD files [Client Utilities CD-ROM]: MacPPD:
OSX This includes the PPD files to enable printing from Macintosh on the Mac OS X 10.2.4 to
10.3.X and Mac OS X 10.4 to...

Page 13: Printing From Windows
PRINTING FROM WINDOWS This chapter provides instructions on how to print from a Windows
computer. Before Using the Printer Driver..................... 12 Configuring the options
............................12 Setting the department code ..........................16 Copying the PPD file for
Windows ........................17 Printing From Application ..................... 18 Considerations and
limitations..........................18 How to print ................................18 Setting Up Print
Options......................

Page 14: Before Using The Printer Driver
2 PRINTING FROM WINDOWS Before Using the Printer Driver Before printing, you have to
configure the following options: Configuration Settings To use optional devices such as optional
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drawers, the Finisher or Hole Punch Unit, you must first configure these devices. The features of
these optional devices are not available unless you inform the system that the optional devices
are installed.

Page 15 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Configuring options
manually If SNMP communication between this equipment and your computer is not available:
Setting the [Device Settings] tab manually You need to log in to Windows with the
“Administrator” privilege. Click [Start] menu and select [Devices and Printers]. The Printers
folder appears.

Page 16 2 PRINTING FROM WINDOWS Display the [Device Settings] tab menu, and set the
following options. Model Selection — This sets the model type. The setup items of the printer
driver are changed according to the model selected. If you select [Universal], you can narrow
down the setup items of the printer driver to those used commonly in all of the e-STUDIO Series.

Page 17 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Set the following options
and click [OK]. Drawer 1 — Select the size and type of paper that is loaded in the 1st Drawer.
Drawer 2 — Select the size and type of paper that is loaded in the 2nd Drawer. Drawer 3 —...

Page 18: Setting The Department Code
2 PRINTING FROM WINDOWS Setting the department code When this equipment is managed by
department codes, you have to enter yours on the printer driver. This allows a network
administrator to check the number of copies printed by specific department members. Also
users can check who submitted the print jobs, by touch panel display and monitoring tools.

Page 19: Copying The Ppd File For Windows
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Select the printer driver of this
equipment, and then click [File] menu and select [Printing Preferences]. If the [File] menu is not
displayed, press [Alt]. The printing preferences dialog box appears. Display the [Others] tab
menu and enter your department code in the [Department Code] box.

Page 20: Printing From Application
2 PRINTING FROM WINDOWS Printing From Application This section describes how to print a
document from application. P.18 “Considerations and limitations” P.18 “How to print”
Considerations and limitations When the User Management setting is enabled, it is used to
manage a print job instead of the Department Code Management setting.

Page 21 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Setting the print options
on each tab according to how you want to print. Setting the print options varies depending on
how you want to print a document. P.27 “Print options” You can also set the print options using
setting profiles. P.21 “Setting print options using profiles”...

Page 22: Setting Up Print Options
2 PRINTING FROM WINDOWS Setting Up Print Options Print Options are the attributes you set to
define the way a print job is processed. For example, the private print and proof print options
determine how the copier manages your print job. To find the printing instructions for your
specific needs, see the procedures in the following section.

Page 23: Setting Print Options Using Profiles
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Setting print options using profiles
Using profiles, you can save the print settings or apply the saved settings to a print job. There
are 5 factory default profiles. BW, Duplex, Staple & 2in1 Color Booklet Duplex &...

Page 24 2 PRINTING FROM WINDOWS Enter the profile name and click [OK]. The file name
must be up to 63 characters long. If you enter an existing profile name, you are prompted to
confirm whether you want to overwrite it. If you want, click [OK].

Page 25 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Deleting profile Select the
profile that you want to delete in the [Profile] box, and click [Delete]. The [Confirm Delete]
dialog box appears. Click [Yes] to delete the selected profile. Setting Up Print Options...

Page 26 2 PRINTING FROM WINDOWS Setting up print options with Template Buttons Once
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you save a profile to a Template Button, the [Templates] dialog box automatically appears upon
printing, and you can immediately apply the saved profile to a print job only by selecting this
Template Button. 5 factory default profiles are registered in a Template Button.

Page 27 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Select a profile to be
saved in the [Profile] box. Select a Template Button to which the chosen profile is saved. If you
select a Template Button that is already registered, the profile saved in this button is replaced
with a new one.

Page 28 2 PRINTING FROM WINDOWS Deleting a profile saved in a Template Button Select
the [Templates] tab. Click [Edit]. The [Edit Templates] dialog box appears. Select a Template
Button whose profile needs to be deleted. Click [Delete] and then [OK]. The profile in the
selected Template Button is deleted. The Template Button is left blank. Setting Up Print
Options...

Page 29: Print Options
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Print options This section describes
print options in each tab of the printer driver. This section will help you to find the description of
specific print options, or understand their individual functions. How to display: Click [Start]
menu and select [Devices and Printers].

Page 30: Hold Print
2 PRINTING FROM WINDOWS - [Image Quality] tab The [Image Quality] tab allows you to select
how images are printed. You can easily select appropriate image quality depending on the type
of job being printed. P.48 “[Image Quality] tab” - [Effect] tab The [Effect] tab contains print
options that add the effects to your print jobs such as Watermarks, Overlay Image printing and
so on.

Page 31 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS - Print to Overlay File
Select this to save the print job as an overlay file that is imposed on other documents. When
you select this, click the button on the right and enter the file name. For example, if you want to
print a master page image on the background of a document, you can create an overlay file of
the master merge image using this option.

Page 32: Basic] Tab
2 PRINTING FROM WINDOWS 11) [Help] Click this to browse Help for the printer driver. [Basic]
tab The [Basic] tab contains basic print operation settings, such as the original paper size, print
paper size, paper source, paper type, destination, number of copies, orientation, and so on. 1)
Original Paper Size This selects the size of a document to be printed.

Page 33 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS There are also 20 custom
paper sizes in the [Print Paper Size] box. You can set the custom paper sizes in the [Others] tab.
P.61 “[Others] tab” 3) Image Scale Select this check box to enter the scale manually to enlarge
or reduce an image. The ratio can be set at between 25 and 400%.

Page 34 2 PRINTING FROM WINDOWS 5) Paper Type This sets the media type of the paper. -
Plain (Auto) — Select this when printing on plain paper. - Plain — Select this when printing on
plain paper. - Recycled — Select this when printing on recycled paper. - Thick1 —...

Page 35 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS 8) Orientation This sets
the paper printing direction. - Portrait — The document is printed in the portrait direction. -
Landscape — The document is printed in the landscape direction. 9) Color This sets whether a
print job is printed in the color or black mode. - Auto —...

Page 36 2 PRINTING FROM WINDOWS 4) Units Select the unit for the Tab Extension and
Image Shift option. The default unit varies depending on the regional setting of the client
computer. Tab paper must be fed from the bypass tray. Make sure to place it with its tab
outside. The shape of the bypass tray differs depending on the model.

Page 37: Finishing] Tab
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS [Finishing] tab The [Finishing] tab
allows you to enable sort printing, 2-sided printing, N-up printing, poster printing, stapling and
punching. 1) Copy Handling This sets how to sort the printed sheets when numerous copies are
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made for printing. - Sort Copies —...

Page 38 2 PRINTING FROM WINDOWS For the detailed instructions on how to print with the
[Copy Handling] setting, see the following page: P.90 “Sort printing” 2) 2-Sided Printing This
sets printing on both sides of paper. Select this check box and then the position of the margin
for 2-sided printing. - Long Edge —...

Page 39 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS 3) Number of pages per
Sheet This sets the printing of multiple pages on one sheet. The pages are reduced to fit the
selected paper size automatically and printed. - 2 pages — Select this to print images from 2
pages arranged on one sheet. - 4 pages —...

Page 40 2 PRINTING FROM WINDOWS - Center Double — Select this to fold and double-staple
the printed document in the center. When you select this, the pages will be printed on the
sheets according to the print option settings, and then simply fold and double- staple in the
center of the sheets.

Page 41 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS 5) Hole Punch This sets
whether a print job is printed with hole punches. - Center Top — Select this to create holes
along the top edge and print. - Middle Left — Select this to create holes along the left side and
print. Hole punching can be selected only when a Hole Punch Unit (optional) is installed.

Page 42 2 PRINTING FROM WINDOWS 7) Use Custom Margin Select this check box to set the
margin on the printed pages. When this box is selected, click [Details] to set the margins in the
[Custom Margin] dialog box. The selectable range of the margin width differs depending on the
model. - For the e-STUDIO6550C Series and e-STUDIO4540C Series 0.17 inch to 3.94 inches /
4.2 mm to 100 mm (The margin width cannot be smaller than 0.17 inches / 4.2 mm.) For
models other than the above, refer to the corresponding Printing Guide.

Page 43: Booklet Details
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Booklet Details In the [Booklet
Details] dialog box, you can specify how Booklet printing is performed. 1) Output Document
Layout Select the booklet size to be made. - A5 on A4 — Select this to print an A5 size booklet.
Every 2 pages are printed on A4 paper to fit on half a sheet (A5).

Page 44 2 PRINTING FROM WINDOWS 7) Folding Select this to have the paper folded at its
center when it exits. The Folding option is available only when any of the finishing sizes below is
selected. [A5 on A4], [A4 on A3], [B5 on B4], [Letter - Half on Letter], [LT on LD], [1/2 LG on LG],
[16K on 8K] The Folding option is available only when the Saddle Stitch Finisher (optional) is
installed.

Page 45 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS [Paper Handling] tab The
[Paper Handling] tab allows you to enable Front Cover printing, Back Cover printing, Inserting
Pages, and Interleaving Pages. “Use Front Cover”, “Use Back Cover”, “Insert Pages” and
“Interleave Pages” are not available when the Tab printing function is set.

Page 46 2 PRINTING FROM WINDOWS Print Style This selects how you want to print a front
cover. - Do not print on page — Select this to insert a blank cover. - Print one side of the page —
Select this to print the first page image on the front side of a cover. - Print both sides of page
—...

Page 47 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS 4) Interleave Pages This
sets the interleaving page feature that is useful when you want to insert paper of a different
type (or from another source) between every page of your print job. For example, you can use
this option to insert blank, colored sheets between overhead transparencies.

Page 48 2 PRINTING FROM WINDOWS 2) Print Style This selects how you want to print on
insertion sheets. - Blank — Select this to insert blank sheets. - 1 Side — Select this to print the
specified page on the front side of the insertion sheets. - 2 Sides —...

Page 49 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS 10) Units Select the unit
for the Tab Extension and Image Shift option. The default unit varies depending on the regional
setting of the client computer. Tab paper must be fed from the bypass tray. Make sure to place
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it with its tab outside. The shape of the bypass tray differs depending on the model.

Page 50: Image Quality] Tab
2 PRINTING FROM WINDOWS [Image Quality] tab The [Image Quality] tab allows you to select
how images are printed. You can easily select the appropriate image quality depending on the
type of document. 1) Image Quality Type This sets how colors are printed by selecting the job
type. The printer driver automatically applies the proper image quality for the selected job type.

Page 51 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Setting: [Basic] tab In the
[Basic] tab of the [Setting] dialog box, you can specify the following functions. The print options
in the [Basic] tab are available only when your equipment is a multifunctional digital color
system. The setup items differ depending on the model.

Page 52 2 PRINTING FROM WINDOWS When you edit an existing custom Image Quality Type,
the settings of this Image Quality Type will be overwritten regardless of whether or not this
Image Quality Type is renamed. Even if you enter any of the default Image Quality Type names
([General], [Photograph], [Presentation], [Line Art] or [Advanced]) registered as default settings,
these default Image Quality types will not be overwritten.

Page 53 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS 9) Black Overprint Select
this check box when printing background content that has black text overlaid on it. If this is
enabled, the gap between the text and the background is minimized and color deviation is
prevented. If this is not enabled, the background of the black content will not be printed.

Page 54 2 PRINTING FROM WINDOWS Setting: [Color Balance] tab In the [Color Balance] tab
of the [Setting] dialog box, you can specify the following functions. Adjust the density level by
moving the scroll bar, or pressing buttons on the right and left of the scroll bar. This option is
available only when you have a multifunctional digital color system.

Page 55 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Setting: [Image Attribute]
tab In the [Image Attribute] tab of the [Setting] dialog box, you can specify the following
functions. Adjust the density level by moving the scroll bar, or pressing buttons on the right and
left of the scroll bar. 1) Contrast Adjust the contrast for printing.

Page 56 2 PRINTING FROM WINDOWS Setting: [Advanced] tab In the [Advanced] tab of the
[Setting] dialog box, you can set the functions below. The color profile data of this equipment
may be updated. If the SNMP communication between this equipment and your computer is
available, open the [Advanced] tab menu and then click [Update Now] to obtain the updated
color profile data.

Page 57: Effect] Tab
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS [Printer’s Default] is a default setting
for RGB Source Profile, CMYK Source Profile, Destination Profile and Rendering Intent. When you
select [Printer’s Default], color space conversion is performed according to the default profile
(that set as a default profile in the [ICC Profile] submenu of the [Setup] menu in the TopAccess
administrator mode).

Page 58 2 PRINTING FROM WINDOWS [Effect] tab for PS3 1) Watermark This selects the
watermark to be used or edited. The following values except [None] are the default watermarks
that have been registered in the printer driver. Up to 15 new watermarks can be added in this
box. - None —...

Page 59 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS When [Overlay Image] is
selected together with the N-up printing, 1 overlay image will be printed on the entire page,
regardless of the number of images set in 1 page. Both the overlay file and the documents on
which you superimpose the overlay image must be created in the same size, color mode and
orientation.

Page 60 2 PRINTING FROM WINDOWS Add/Edit Watermark When you click [Add] or [Edit], the
[Watermark] dialog box appears and you can create new watermark or edit selected
watermarks. 1) Position Select this to adjust the position of the watermark. Click the arrow
button or [+] located at the center to adjust it. 2) Caption Enter the text of a watermark.

Page 61 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Multiple Overlays If you
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click [Details] when [Multiple Overlays] or the desired overlay is selected in the [Overlay Image]
box, the [Multiple Overlays] dialog box appears. Set which overlay image is applied to which
page in this dialog box. 1) Overlay Images The registered overlay images are displayed in a
thumbnail.

Page 62 2 PRINTING FROM WINDOWS 6) Select setting to clear This selects the overlay image
setting to be cleared. 7) [Clear] This clears the overlay image setting selected in the [Select
setting to clear]. 8) [Restore Defaults] Click this to restore the settings displayed in the [Multiple
Overlays] dialog box to the original factory defaults. Setting Up Print Options...

Page 63 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS [Others] tab The [Others]
tab contains print options such as toner saving, custom paper size and so on. [Others] tab for
Universal Printer (PCL6)/XPS [Others] tab for Universal Printer (PS3)/PS3 1) Default Menu Setting
Select the default tab that is displayed when you open the printing preferences of the printer
driver.

Page 64 2 PRINTING FROM WINDOWS 2) TopAccess (Link) Click this to start a web browser
and display the TopAccess menu. 3) Toner Save Select this check box to print in the toner save
mode. When the toner save mode is enabled, printing may become lighter. 4) Do not Print Blank
Pages Select this check box to ignore blank pages for printing.

Page 65 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS 11) User name (Alias)
Enter a nickname as required, which is displayed on the Private Print job list and Hold Print job
list. You can specify the desired name so that you can easily find the target job from the job list
when releasing it from the equipment’s touch panel.

Page 66: Snmp Settings
SNMP Settings 1) Version Be sure to have the correct SNMP version set for your TOSHIBA MFP
and select from the following options: - V1/V2 — Select this option to enable SNMP V1 and V2. -
V3 — Select this option to enable SNMP V3.

Page 67: Add Printer
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS 3) SNMP V3 If SNMP V3 is enabled,
select one of the following items to set how users are authenticated. User ID File — Select this
option when you want to use a user ID file. Click [Browse] and specify the user ID file. User
Name/Password —...

Page 68: Custom Paper Size
2 PRINTING FROM WINDOWS 4) Available Printer List This indicates the e-STUDIO Series printers
registered in [Printer Folder]. Custom Paper Size In the [Custom Paper Size] dialog box, up to 20
custom paper sizes can be defined. The custom page size that you specify can be selected in
the [Original Paper Size] and [Print Paper Size] box on the [Basic] tab.

Page 69: Device Settings] Tab
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS [Device Settings] tab The [Device
Settings] tab allows you to configure options. When any optional unit is installed in this
equipment, set the configuration of the machine on this tab. The [Device Settings] tab can be
displayed only from the Printers folder (and not when displaying the properties from the
application’s print dialog box).

Page 70 2 PRINTING FROM WINDOWS 3) Finisher This sets whether or not the Finisher
(optional) is installed. - None — Select this when a Finisher (optional) is not installed. - Hanging
Finisher — Select this when a Hanging Finisher (optional) is installed. - Finisher —...

Page 71: Drawer Settings
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS If you disable SNMP Communication,
TopAccessDocMon notification also will be disabled. 12) [Restore Defaults] Click this to restore
the configuration of this equipment displayed in the [Device Settings] tab menu to the original
factory defaults.

Page 72: Account Settings
2 PRINTING FROM WINDOWS Account Settings When SNMP communication is enabled, the
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following account information is automatically obtained from the equipment. 1) Use User
Authentication Select this check box to enable the user management function. 2) User Name
The user name that is entered to log in to your computer is displayed. 3) Domain Name The
domain name on which the equipment belongs is displayed.

Page 73 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Customization: [Plug-in]
tab You can enable or disable the Plug-in setting. 1) Paper Handling Select this check box to
enable the [Paper Handling] tab. P.43 “[Paper Handling] tab” 2) Image Quality Select this check
box to enable the [Image Quality] tab. P.48 “[Image Quality] tab”...

Page 74 2 PRINTING FROM WINDOWS Customization: [Language] tab You can switch printer
driver language. 1) Language This selects the language to be used. - Auto / Chinese (Simplified)
/ Chinese (Traditional) / Danish / Dutch / English (UK) / English (US) / Finnish / French / German /
Italian / Japanese / Norwegian, Bokmål / Polish / Russian / Spanish / Swedish [Auto] is selected
by default.

Page 75 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Customization: [PDL
Settings] tab The Printer Driver setting is available only for a Universal Printer driver and a PS3
printer driver. 1) Output PDL This selects the printer driver language (PDL) to be printed. The
setting can be changed only when a Universal Printer driver is used.

Page 76 2 PRINTING FROM WINDOWS [Templates] tab You can register print options that you
frequently use as a profile. On the [Templates] tab you can save this profile in a Template
Button. Also you can display a dialog box for selecting Template Buttons automatically upon
printing, enabling easy printing with profiles.

Page 77: Edit Templates
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Edit Templates You can edit the
settings of the Template Buttons. 1) Profile This selects the profile to be saved in a Template
Button. 2) Template Button This selects the Template Button to be edited. 3) [Save] This saves
the chosen profile in the selected Template Button.

Page 78: Printing With Best Functions For Your Needs
2 PRINTING FROM WINDOWS Printing With Best Functions for Your Needs In this section,
procedures are given to print various types of print jobs, using the layout and finishing options.
Read this section before starting printing and select the procedure best suited for your needs.
P.76 “Printing various print job types”...

Page 79: Printing Scheduled Print Jobs
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Printing scheduled print jobs The
Print Scheduling feature allows you to specify the date and time to print your job. This is
especially useful for delaying your print job until the off-peak hours. Time of the System and
MFP should be the same.

Page 80: Printing Private Print Jobs
2 PRINTING FROM WINDOWS Printing private print jobs When you want to print private
documents, use this feature. The Private Print function can be used when the user management
setting is disabled on the equipment. Printing confidential documents Display the [Basic] tab
menu. Select [Private Print] in the [Print Job] box.

Page 81 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Enter the password for
the Private Print job, which has previously been set via the computer, and then press [OK].
When the user name that is entered to log in to your computer is used for [User name (Alias)]:
The displayed list contains the Private Print jobs for which the same password has been set.

Page 82: Printing Proof Print Jobs
2 PRINTING FROM WINDOWS Printing proof print jobs You can print out one proof copy as a trial
first. This helps to prevent wasting paper. After you proof it, you are prompted to specify
whether you want to continue the print job or delete it. When you want to print multiple copies,
each of which is to be sent as an individual print job by your application, all the copies, not just
one copy, will be printed even if you set Proof Print.
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Page 83: Creating An Overlay File
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Creating an overlay file You can save
up to 20 documents as overlay files using printer driver. You can print an overlay on the
foreground or background of a document. To do that, you must first create an overlay file. P.104
“Printing with an overlay file”...

Page 84 2 PRINTING FROM WINDOWS Storing to e-Filing The Store to e-Filing feature allows
you to send print jobs to e-Filing on this equipment. The job stored to e-Filing can then be
printed from the touch panel display at a later time. It can be also composed with other
documents using the e-Filing web utility.

Page 85 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS When you specify a folder
in which the print job is to be stored in a Public Box, enter the folder name in the [Box Folder]
box. If the entered folder name is not found, a new folder is created under this folder name.
Enter the folder name within 64 characters.

Page 86 2 PRINTING FROM WINDOWS When you specify a folder in which the print job is to be
stored in a user box, enter the folder name in the [Box Folder] box. If the entered folder name is
not found, a new folder is created under this folder name. Enter the folder name within 64
characters.

Page 87 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Multiple Job Type The
Multiple Job Type feature allows you to combine any of Scheduled Print, Private Print, Hold Print,
Proof Print, Proof Private Print and Proof Hold Print, with Store to e-Filing. For example, you can
store a job in the specified e-Filing of this equipment and print it at the specified time by
combining Scheduled Print and Store to e-Filing.

Page 88 2 PRINTING FROM WINDOWS Select a job type in the [Print Job] box. The setup
screen is switched according to the selected job type. Set [Date] and [Time] if you select
[Scheduled Print]. Enter a password if you select [Private Print] or [Proof Private Print]. Enter a
password using the alphanumeric characters and symbol characters (ASCII code characters
between 0x21 to 0x7E) in the [Password] box.

Page 89 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Select where the print job
is stored at the [Store to] box. If you store the print job in a user box, enter a password if
required. When you specify a folder in which the print job is to be stored in the selected e-Filing,
enter its folder name in the [Box Folder] box.

Page 90: Layout And Finishing Options In [Basic] Tab Menu
2 PRINTING FROM WINDOWS Layout and finishing options in [Basic] tab menu Using the printer
driver, you can set various layout options to suit your preferences. In this section various
printing functions enabled with the [Basic] tab menu are explained. P.88 “Fitting images within
paper size”...

Page 91 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Combining a paper size
and a reproduction ratio You can combine the desired paper size and reproduction ratio, for
example, printing an A4 original to A3 copy paper at a reproduction ratio of 100%. Display the
[Basic] tab menu.

Page 92: Layout And Finishing Options In [Finishing] Tab Menu
2 PRINTING FROM WINDOWS Printing color documents in twin colors This equipment can print in
the twin color mode. When the document is printed in the twin color mode, the black parts of
the document are printed in black and the colored parts of the document are printed in a
specified color.

Page 93 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Select [Sort Copies] icon
at [Copy Handling]. Set any other print options you require and click [OK]. Click [OK] or [Print] to
send the print job. The printed documents are sorted according to the copies. Sorting printed
documents according to the pages For example, assume that you have a three-page job (A, B,
C) and you want three copies of each page in this order (AAA, BBB, CCC).

Page 94: Printing On Both Sides Of A Sheet
2 PRINTING FROM WINDOWS Printing on both sides of a sheet You can print on both sides of the

https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=83#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=84#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=85#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=86#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=87#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=88#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=89#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=90#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=91#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=92#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=93#manual
https://capturecode.com/manual/450389/Toshiba-E-Studio400p.html?page=94#manual


paper. Printing on both sides of paper Display the [Finishing] tab menu. Select the [2-Sided
Printing] check box and select the direction to be printed. Long Edge —...

Page 95 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Select the booklet size at
the [Output Document Layout] box. A5 on A4 — Select this to print an A5 size booklet. Every 2
pages are printed on A4 paper to fit on half a sheet (A5).

Page 96 2 PRINTING FROM WINDOWS Select the [Folding] check box if you want to fold the
document at its center. The Folding option is available only when the Saddle Stitch Finisher
(optional) is installed. If you want to double-staple the center, select the [Staple Down the
Center] check box. [Staple Down the Center] is available only when the Saddle Stitch Finisher
(optional) is installed and configured on the [Device Settings] tab.

Page 97: Printing Several Pages On One Sheet
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Printing several pages on one sheet
The N-up feature allows you to print several pages of a document on one sheet of paper. This
feature is very useful for browsing a large number of pages for appearance or page order. For
example, to check the navigation path of a number of web pages or review the narrative of a
slide presentation, using N-up is not only convenient but conserves paper as well.

Page 98: Hole Punching
2 PRINTING FROM WINDOWS Stapling You can staple sets of paper to exit from the equipment.
Stapling is not available if a Finisher (optional) is not installed. Stapling the paper Display the
[Finishing] tab menu. Select the [Staple] check box. Select a stapling option. Upper Left —...

Page 99 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Dividing one image into
multiple sheets (Poster Print) You can print one large image into more than one sheet of paper
by dividing it. The divided images on the multiple sheets of paper are then reconnected, so that
you can create a large publication such as a poster. The Poster Print option is not available
when any of the Custom Paper Size, Number of pages per sheet, 2-Sided Printing, Watermark,
Overlay Image and Sheet Insertion options is set.

Page 100: Finishing Options In [Paper Handling] Tab Menu
2 PRINTING FROM WINDOWS Finishing options in [Paper Handling] tab menu Using the printer
driver, you can set various layout options to suit your preferences. In this section various
printing functions enabled with the [Paper Handling] tab menu are explained. P.98 “Inserting
different types of paper”...

Page 101 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Enter the page numbers
to which you want to insert the sheet in each [Page] box and select the [Print Style], [Paper
Source], and [Paper Type] options as you require. Set any other print options you require and
click [OK]. Click [OK] or [Print] to send the print job.

Page 102 2 PRINTING FROM WINDOWS Interleaving pages This feature is useful when you
want to insert a different type of paper, or from another source, between every page of your
print job. For example, you could use this option to insert blank or color sheets between
overhead transparencies. Inserting sheets between every page of a print job Display the [Paper
Handling] tab menu.

Page 103: Finishing Options In [Effect] Tab Menu
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Finishing options in [Effect] tab menu
Using the printer driver, you can set various layout options to suit your preferences. In this
section various printing functions enabled with the [Effect] tab menu are explained. P.101
“Printing with watermarks”...

Page 104 2 PRINTING FROM WINDOWS Creating or editing a watermark Click [Add] to create
a new watermark, or select one that you want to edit and click [Edit] to edit a watermark. The
[Watermark] dialog box appears. Enter the watermark text in the [Caption] box. You can enter
up to 63 characters for the [Caption] box.

Page 105 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Deleting a watermark
You can delete the default watermarks. However, they cannot be restored by clicking [Restore
Defaults]. Select the watermark that you want to delete at the [Watermark] box. Click [Delete].
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The [Confirm Delete] dialog box appears. Click [Yes].

Page 106: Printing With An Overlay File
2 PRINTING FROM WINDOWS Printing with an overlay file Using image overlays ensures that
widely-used images are readily available and consistently reproduced. Image overlays are
independent documents that are merged into other documents during printing and thereby
increase the time required to print a job.

Page 107 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Deleting an overlay
image Select an overlay image that you want to delete at the [Overlay Image] box. Click
[Delete]. The [Confirm Delete] dialog box appears. Click [Yes]. The overlay image is deleted.
Printing With Best Functions for Your Needs...

Page 108: Using Various Types Of Paper
2 PRINTING FROM WINDOWS Using various types of paper This equipment allows you to print on
various types of paper. The procedure below is for print jobs which require precautions before
you place the paper. P.106 “Printing on tab paper” P.108 “Printing on paper larger than
standard sizes”...

Page 109 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS When printing a
document, display the [Basic] tab menu of the printer driver properties, select the document
size in the [Original Paper Size] box and either [Letter Tab] or [A4 Tab] (according to the
document size) in the [Print Paper Size] box. The [Primary Tab Dialog] dialog box appears.

Page 110: Control Panel
2 PRINTING FROM WINDOWS Printing on paper larger than standard sizes The procedure below
is for printing on paper larger than standard sizes defined in the custom paper size setting.
(Example: Largest size: 12.34 x 47.24 inches (313.4 x 1200 mm)) Custom paper sizes can be
defined in the [Other] tab menu.

Page 111 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Inserting from the
bypass tray When the paper is being fed into the equipment Do not mix paper of different sizes.
Place one sheet at a time on the bypass tray even if you wish to print multiple copies. Slightly
curl the paper.

Page 112: Switching Equipment To Print Jobs
2 PRINTING FROM WINDOWS Switching equipment to print jobs When more than one piece of e-
STUDIO Series equipment exists over a network, you can switch it to another one on the printer
driver menu. If the equipment that you intended to use is busy with a large number of print
jobs, for example, you can send your job to another piece of e-STUDIO Series equipment that is
currently holding no print jobs and have it printed.

Page 113: Splitting A Print Job Across Two Pieces Of Equipment
(Tandem Printing)
2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Click [OK] or [Print] to send the print
job. A job is printed on the selected equipment. If the selected equipment does not support
features enabling the print options of the job, printing may not be performed properly.

Page 114 2 PRINTING FROM WINDOWS Select two pieces of equipment in the [Selected
Devices] boxes and then specify the number of copies for each one. If you select the [Auto]
check box, the number of copies set in the [Total Copies] box is automatically and equally
allocated to two pieces of equipment.

Page 115 PRINTING FROM Macintosh This chapter provides the instructions on how to print
from a client computer. Printing From Application on Mac OS X 10.2.4 to Mac OS X 10.6.x ........
114 Considerations and limitations..........................114 How to print from Mac OS X 10.2.4 to
Mac OS X 10.6.x ................... 115 Page Setup dialog on Mac OS X 10.2.4 to Mac OS X 10.6.x
................

Page 116: Printing From Application On Mac Os X 10.2.4 To Mac Os X
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10.6.X
3 PRINTING FROM Macintosh Printing From Application on Mac OS X 10.2.4 to Mac OS X 10.6.x
Once you have installed the PPD file as described in “Installing the Printer on Mac OS X 10.2.4 to
Mac OS X 10.6.x” of the Software Installation Guide, you can print directly from most of the Mac
OS X applications.

Page 117: How To Print From Mac Os X 10.2.4 To Mac Os X 10.6.X
3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh How to print from Mac OS X 10.2.4 to
Mac OS X 10.6.x You do not need to switch printers before starting printing because they are all
managed under the setting of [Print & Fax] of [System Preferences].

Page 118: Page Setup Dialog On Mac Os X 10.2.4 To Mac Os X 10.6.X
3 PRINTING FROM Macintosh Page Setup dialog on Mac OS X 10.2.4 to Mac OS X 10.6.x The
[Page Setup] dialog boxes can be displayed by selecting the [Page Setup] command from the
[File] menu of the application. In the [Page Setup] dialog boxes, you can specify the Page
Attributes settings and manage the Custom Page Size settings.

Page 119: Custom Page Sizes
3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Custom Page Sizes The PPD file for
this equipment supports the Custom Page Sizes. The procedure to create the Custom Page Size
varies between the Mac OS X 10.4.x to Mac OS X 10.6.x and Mac OS X 10.2.4 to Mac OS X
10.3.x.

Page 120 3 PRINTING FROM Macintosh Double-click the added custom page size name on the
list and rename the custom page size. Enter the width and height in the [Page Size] boxes, and
select the printer name of this equipment in the [Printer Margins] box. If Mac OS X 10.6.x is
used, enter the width and height in the [Paper Sizes] box, and then select your printer name in
the [Non-Printable Area] box.

Page 121 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Creating Custom Page
Size on Mac OS X 10.2.4 to Mac OS X 10.3.x Select [Custom Paper Size] in the [Settings] box.
The Custom Paper Size menu is displayed. Click [New]. A new custom page size name is added
to the list. If you want to create a new custom page size by duplicating an existing custom page
size, select the custom page size name on the list and click [Duplicate].

Page 122 3 PRINTING FROM Macintosh Enter the height and width in the [Page Size] boxes,
and enter the printer margins in the [Printer Margins] boxes. In the [Printer Margins] box, please
enter “0.17” inch. You can delete the created custom page size by clicking [Delete]. Click [Save]
and click [OK].

Page 123: Print Dialog On Mac Os X 10.3.X To Mac Os X 10.6.X
3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Print dialog on Mac OS X 10.3.x to
Mac OS X 10.6.x The [Print] dialog boxes can be displayed by selecting the [Print] command
from the [File] menu of the application. The [Print] dialog boxes are different between Mac OS X
10.2.x and Mac OS X 10.3.x to Mac OS X 10.6.x. Please see the following section for the
descriptions of the [Print] dialog boxes for Mac OS X 10.2.x.

Page 124 3 PRINTING FROM Macintosh Layout In the Layout menu, you can set N-up printing
(multiple pages per sheet). 1) Pages per Sheet This sets the number of multiple pages printed
on one sheet. The pages are reduced to fit the selected paper size automatically and are
printed.

Page 125: Output Options
3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh 4) Two-Sided This sets whether or not
you want to print on both sides of the paper. - Off — Select this when you do not want to print
on both sides of the paper. - Long-Edge binding —...

Page 126: Paper Handling
3 PRINTING FROM Macintosh Scheduler In the Scheduler menu, you can set when a print job will
be sent to the equipment. 1) Print Document This sets when a print job will be sent to the
equipment. - Now — Select this to send a print job now. - At —...
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Page 127 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Mac OS X 10.4.x 1) Page
Order Select the page order for printing. 2) Print Select whether to print all pages or only
odd/even-numbered pages. 3) Destination Paper Size Select the output paper size. - Use
documents paper size —...

Page 128 3 PRINTING FROM Macintosh Mac OS X 10.6.x 1) Pages to Print Select whether all
pages will be printed or only odd or even pages will be printed. 2) Page Order Select the page
order for printing. 3) Destination Paper Size Select the output paper size.

Page 129: Color Matching
3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Color Matching In the Color Matching
menu you can adjust the colors on the printouts. This menu is displayed only for Mac OS X
10.5.x to Mac OS X 10.6.x. 1) ColorSync Select this if you want the application you are using to
control the color management of the printouts. 2) In Printer Select this if you want the printer
you are using to control the color management of the printouts.

Page 130: Cover Page
3 PRINTING FROM Macintosh Cover Page In the Cover Page menu, you can set whether to send
a print job with a banner page. The banner page includes information about the job owner, job
name, application name, date and time, and printer name. 1) Print Cover Page You can set how
to insert a banner page.

Page 131: Error Handling
3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Error Handling This menu is displayed
only for Mac OS X 10.3.x to Mac OS X 10.4.x. In the Error Handling menu, you can set how to
report a PostScript error. 1) PostScript Errors This sets whether to print a PostScript error report.

Page 132 3 PRINTING FROM Macintosh Color Settings In the Color Settings 1 and Color
Settings 2 menus, you can adjust the color settings for printing. Color Settings 1 Color Settings
1 (Mac OS X 10.3.x) Printing From Application on Mac OS X 10.2.4 to Mac OS X 10.6.x...

Page 133 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Color Settings 2 1) Color
Type This sets whether to print a job in the color mode or the black mode. - Auto — Select this
to determine the color mode automatically. When a print job is a black and white document, the
system automatically prints the document in the black mode.

Page 134 3 PRINTING FROM Macintosh 4) Image Type This sets how colors are printed by
selecting the job type. The printer driver automatically applies the proper image quality to the
selected job type. - General — Select this when printing a general color document. - Photo —...

Page 135: Advanced Color Settings
3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh 11) Image Attribute This sets the
sharpness, brightness, contrast, saturation and background adjustment for printing. - Sharpness
Adjusts the sharpness for printing. You can set from -4 (softest) to 4 (sharpest) by moving the
scroll bar when the [Use Sharpness Filter] check box is selected.

Page 136: Print Mode
3 PRINTING FROM Macintosh 2) CMYK Source profiles This selects CMYK source profile. When
you obtained color profile data from this equipment, its CMYK source profile data appear. 3)
Apply to Device Color only Select this check box when you give priority to color profiles
embedded in the image. 4) Destination profiles This selects destination profile.

Page 137 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh 2) Print Mode This sets
the type of print job. - Normal — Select this to print a job normally. - Proof — Select this to print
the first copy of a multicopy job and then wait for approval before printing the remaining copies.

Page 138: Printer Features
3 PRINTING FROM Macintosh Printer Features In the Printer Features menu, you can set special
printing features. Finishing In the Finishing menu, you can set the destination, hole punching
and stapling. 1) Destination This selects the destination tray. - Printer’s Default — Select this to
set the output to the default tray (that is set as such for raw jobs in the Printer setting page of
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TopAccess Administrator’s page).

Page 139 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh 2) Hole Punch This sets
whether or not a print job is hole punched. - Off — Select this to print without hole punches. -
Long Edge Punch without rotation — Select this to create holes on the left side for a portrait
document, or on the top for a landscape document.

Page 140 3 PRINTING FROM Macintosh - Lower Left (Portrait) / Upper Left (Landscape) —
Select this to staple on the lower left for a portrait document, or on the upper left for a
landscape document. - Upper Right (Portrait) / Lower Right (Landscape) — Select this to staple
on the upper right for a portrait document, or on the lower right for a landscape document.

Page 141 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh This option cannot be
selected if a Finisher (optional) is not installed. [Saddle Stitch (Portrait) / Saddle Stitch
(Landscape)] can be selected only when the Saddle Stitch Finisher (optional) is installed.
Stapling cannot be enabled when [Tray 1] is selected at the [Destination] option. 4) Folding
Select this check box to have paper folded at its center when it exits after data are printed
according to the set print options.

Page 142: Cover Pages
3 PRINTING FROM Macintosh Cover Pages In the Cover Pages menu, you can set Front Cover
printing and Back Cover printing. This option menu cannot be set when the Cover Page option
for sending a print job with a banner page is enabled. 1) Use Front Cover This sets front cover
printing which allows you to insert or print a cover on a sheet fed from a different drawer or the
bypass tray.

Page 143 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh The selectable values in
the [Source] box vary depending on the optional devices installed on this equipment and their
configuration on the Paper Feed menu. Print Style This selects how you want to print a back
cover. - Do not print on page —...

Page 144: Digit Password
3 PRINTING FROM Macintosh e-Filing In the e-Filing menu, you can send and store print jobs
from your application to e-Filing on this equipment (hard disk). The jobs stored to e-Filing can
then be printed using the touch panel. You can select either a public or user box in which to
store print jobs.

Page 145 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Watermark In the
watermark menu, you can overprint the document with useful information, such as
[Confidential], [Draft], [Proof] and [Top Secret]. You can choose from several predefined
watermarks or you can create and save your own custom watermarks.

Page 146: Supply Levels
3 PRINTING FROM Macintosh 7) Print under the document Select this to print the watermark text
placed below everything. 8) Position Adjust the position of the watermark by moving the scroll
bars. Supply Levels In the Supply Levels menu, the remaining toner and paper can be checked.
This menu is displayed when Mac OS X 10.4 to 10.6.x is used.

Page 147: Print Dialog On Mac Os X 10.2.X
3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Print dialog on Mac OS X 10.2.x The
[Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu of
the application. The [Print] dialog boxes are different between Mac OS X 10.2.x and Mac OS X
10.3.x to Mac OS X 10.5.x. Please see the following section for the descriptions of the [Print]
dialog box for Mac OS X 10.3.x to Mac OS X 10.5.x.

Page 148 3 PRINTING FROM Macintosh Layout In the Layout menu, you can set N-up printing
(multiple pages per sheets). The items in the Layout menu vary depending on the Mac OS X
version. 1) Pages per Sheet This sets the number of multiple pages to be printed on one sheet.
The pages are reduced to fit the selected paper size automatically and are printed.

Page 149 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Duplex In the Duplex
menu, you can set Two-Sided printing (printing on both sides of a sheet). 1) Print on Both Sides
Select this check box to print on both sides of the paper. When this box is selected, select the
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binding direction at the [Binding] option.

Page 150 3 PRINTING FROM Macintosh Error Handling In the Error Handling menu, you can
set how to report a PostScript error. 1) PostScript Errors This sets whether to print a PostScript
error report. - No special reporting — Select this if you do not want to print PostScript error
information. - Print detailed report —...

Page 151 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Printer Features In the
Printer Features menu, you can set special printing features. P.149 “Booklet” P.150 “Color
Settings 1” P.151 “Color Settings 2” P.152 “Color Settings 3” P.152 “Color Settings 4 5” P.153
“Color Settings 4 6” P.153 “Finishing”...

Page 152: Color Settings
3 PRINTING FROM Macintosh Color Settings 1 In the Color Settings 1, you can set special
features for printing. 1) Color Type This sets whether to print a job in the color mode or black
mode. - Auto — Select this to determine the color mode automatically. When a print job is a
black and white document, the system automatically prints the document in the black mode.

Page 153 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Color Settings 2 In the
Color Settings 2, you can set image quality for printing. 1) Image Type This sets how colors are
printed by selecting the job type. The printer driver automatically applies proper image quality
for selected job type.

Page 154 3 PRINTING FROM Macintosh Color Settings 3 In the Color Settings 3, you can set
color balance for printing. 1) Color Balance - Cyan Adjusts the density of cyan for printing. You
can set from -4 to 4. 2) Color Balance - Magenta Adjusts the density of magenta for printing.

Page 155 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Color Settings 4 6 In the
Color Settings 4 6, you can set image attributes for printing. 1) Background Adjustment Adjusts
the density level of the background. You can set from -4 (lightest) to 4 (darkest). Finishing In the
Finishing menu, you can set the destination, hole punching and stapling.

Page 156 3 PRINTING FROM Macintosh 2) Hole Punch This sets whether or not a print job is
hole punched. - Off — Select this to print without hole punches. - Long Edge Punch without
rotation — Select this to create holes on the left side for a portrait document, or on the top for a
landscape document.

Page 157 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh - Lower Left (Portrait) /
Upper Left (Landscape) — Select this to staple on the lower left for a portrait document, or on
the upper left for a landscape document. - Upper Right (Portrait) / Lower Right (Landscape) —
Select this to staple on the upper right for a portrait document, or on the lower right for a
landscape document.

Page 158: Printing Modes
3 PRINTING FROM Macintosh This option cannot be enabled if a Finisher (optional) is not
installed. [Saddle Stitch (Portrait) / Saddle Stitch (Landscape)] can be selected only when the
Saddle Stitch Finisher (optional) is installed. 4) Folding Select this check box to have paper
folded at its center when it exits after data are printed according to the set print options.

Page 159 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh 2) Department Code
Select this check box if a department code is required for printing. When this is enabled, specify
the department code in the DC menu. Enabling the department code depends on whether this
equipment is managed with department codes or not. Please ask your administrator for your
department code.

Page 160 3 PRINTING FROM Macintosh Printing Modes DC In the Printing Modes DC menu,
you can specify your department code, if this equipment is so enabled. Before specifying the
department code, you must check the Department Code option in the Printing Modes menu.
Then specify the department code in this menu.

Page 161 3 PRINTING FROM Macintosh 3.PRINTING FROM Macintosh Private Document
Password In the Private Document Password menu, you can specify the Document ID number
for the private job. It is recommended to specify the Private Document Password when you
select to print a private job. If you do not specify the Private Document Password, the private
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job uses default Private Document Password “00000”.

Page 163 PRINTING FROM UNIX/Linux This chapter provides the instructions on how to print
from a UNIX/Linux workstation. Printing From Application ....................162 Considerations and
limitations..........................162 Printing using lp command ..........................162 Generic “lp” and
“lptap” options ..........................162 General options ..............................163 PCL5e specific
options............................174...

Page 164: Chapter 4 Printing From Unix/Linux
4 PRINTING FROM UNIX/Linux Printing From Application This section describes how to print from
a UNIX/Linux workstation. When the User Management setting is enabled, a print job sent from
UNIX/Linux workstations is processed as an invalid job according to the User Authentication
Enforcement setting. For more information about the User Authentication Enforcement setting,
refer to the TopAccess Guide.

Page 165: General Options
4 PRINTING FROM UNIX/Linux 4.PRINTING FROM UNIX/Linux General options Options below
apply to all print jobs of the e-STUDIO6550C Series and the e-STUDIO4540C Series. Option
commands are case sensitive and must be entered exactly as shown. Some printing functions
may be disabled depending on the combinations of option commands because priority is given
to the specifications of this equipment over option commands.

Page 166 4 PRINTING FROM UNIX/Linux Stapling This sets whether a print job is printed with
staples. When the optional Finisher is installed it can be activated using the following option.
Option Value Alternate Value Description staple=0 Stapling is turned off. staple=1 Staple in the
top left corner of a portrait page and the upper right corner of a landscape page.

Page 167: Output Bin
4 PRINTING FROM UNIX/Linux 4.PRINTING FROM UNIX/Linux Output Bin The output bin can be
specified using the following options. Option Value Alternate Value Description inner Select the
inner tray. bin1 Select the upper output tray of the Finisher (optional). bin2 Select the lower
output tray of the Finisher (optional).

Page 168: Paper Source
4 PRINTING FROM UNIX/Linux Paper Source The paper source can be selected using the
following options. Option Value Alternate Value Description auto-source Select auto paper tray
selection. manual Select Bypass Tray. drawer1 upper Select the 1st drawer. cas1 drawer2 lower
Select the 2nd drawer.

Page 169: Paper Size
4 PRINTING FROM UNIX/Linux 4.PRINTING FROM UNIX/Linux Paper Size The current paper size
can be specified using the following options. Option Value Alternate Value Description letter
Select Letter size paper. Select A4 size paper. legal Select Legal size paper. statement Select
Statement size paper.

Page 170: Department Code
4 PRINTING FROM UNIX/Linux Department Code The department code can be set using the
following option. Option Value Alternate Value Description dept=code Set the department code.
A department code within 63 characters comes in [code]. A department code is specified within
63 characters. If the entered department code is longer than 63 characters, it is clipped to 63
characters when a job is sent.

Page 171: Toner Save
4 PRINTING FROM UNIX/Linux 4.PRINTING FROM UNIX/Linux Toner Save The toner save mode
can be set using the following option. Option Value Alternate Value Description tonersave=on
Set the toner save mode. tonersave=off Cancel the toner save mode. Example: The command
to set the toner save mode is “lp -o tonersave=on <filename>”. Booklet Modes The booklet
mode can be selected using the following options.

Page 172: Page Layout
4 PRINTING FROM UNIX/Linux Page Layout The booklet mode page layout can be selected using
the following options. Option Value Alternate Value Description left2right=off Select right to left
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page layout for the booklet printing mode. This value decides the layout of the pages in the
booklet.

Page 173: Font Pitch
4 PRINTING FROM UNIX/Linux 4.PRINTING FROM UNIX/Linux Collate The collate option can be
selected using the following options. Option Value Alternate Value Description collate=off
Cancel the collate printing mode. collate=on Set the collate printing mode. f this option is not
specified, the default value of “collate=on” will be used. Example: The command to select
collate off is “lp -o collate=off <filename>”.

Page 174: Color Mode
4 PRINTING FROM UNIX/Linux Color Mode This sets whether a print job is printed in color, mono,
or twin color. The color mode for printing mode can be selected using the following options.
Option Value Alternate Value Description colormode= color Set color mode printing for the print
mode.

Page 175: Black Overprint
4 PRINTING FROM UNIX/Linux 4.PRINTING FROM UNIX/Linux Halftone This sets the appropriate
processing on halftone images. The halftone can be selected using the following options. Option
Value Alternate Value Description halftone=AUTO Set the proper halftone depending on the
contents in the document automatically.

Page 176: Pcl5E Specific Options
4 PRINTING FROM UNIX/Linux PCL5e specific options Some of the options only apply to plain
text or PCL5e files. Text Wrapping The following options control text wrapping when it reaches
the right margin. Option Value Alternate Value Description wrap Enable automatic text
wrapping. nowrap Disable automatic text wrapping.

Page 177: Banner Page
4 PRINTING FROM UNIX/Linux 4.PRINTING FROM UNIX/Linux Banner Page A banner page is
automatically generated for each file in each job. The banner page is always sent as a PCL5e
job, including the following items. Name of the user who performed printing Job ID number and
workstation name from which the job was sent Job title (This can be specified using the “-t”...

Page 178 4 PRINTING FROM UNIX/Linux Banner Options The banner page can be printed
using the following options. Option Value Alternate Value Description banner=last Print the
banner page after the job so that it will be physically on top of the job in the output tray.
banner=first banner Print the banner page before the job so that it will be...

Page 179 MANAGING PRINT JOBS FROM THE CONTROL PANEL This chapter describes how to
use the control panel to control the print jobs and monitor the equipment. Monitoring the Print
Job Status ..................178 Normal Print / Scheduled Print jobs ........................178 Proof Print jobs
..............................183 Private Print jobs ..............................186 Hold Print jobs
..............................190 Invalid jobs .................................194...

Page 180: Monitoring The Print Job Status
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Monitoring the Print Job Status Your print
jobs can be monitored on the equipment’s touch panel. The types of print jobs you can monitor
include Normal Print, Scheduled Print, Private Print, Hold Print and Proof Print. If the Department
Management feature is enabled, the equipment can also display the Invalid jobs, which are held
without being printed.

Page 181: Deleting Jobs
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS FROM THE
CONTROL PANEL Deleting jobs Follow the procedure below when you want to delete
unnecessary Normal Print / Scheduled Print jobs. On the [JOBS] tab listing the print jobs ( P.178),
select the job that you want to delete, and then press [DELETE].

Page 182 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Pausing/Resuming jobs Jobs
whose status is “Wait” can be held in the queue (Pausing). Pausing jobs On the [JOBS] tab listing
the print jobs ( P.178), select the job that you want to pause and then press [PAUSE]. The
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selected job is paused.

Page 183 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL Changing the job order You can change the order of the jobs by
moving them within the list. You can only move jobs from and to those whose status is “Wait”.
On the [JOBS] tab listing the print jobs ( P.178), select the job that you want to move in the list,
and then press [MOVE].

Page 184 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Confirming the information of
a skipped job You can confirm the information of a job skipped by the Job Skip function. On the
[JOBS] tab listing the print jobs ( P.178), confirm the information of the skipped job.

Page 185: Proof Print Jobs
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS FROM THE
CONTROL PANEL Proof Print jobs Proof Print refers to the function to print only a single copy as a
sample and suspend the rest of the job when you print multiple copies from a computer on the
network.

Page 186 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Printing remaining copies
Follow the procedure below if you have checked the first copy and want to print the remaining
copies. On the Proof Print job list ( P.183), select the job for printing. If the target job is not
displayed on the screen, use to change between pages.

Page 187 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL Deleting Proof Print jobs Follow the procedure below to delete Proof
Print jobs. On the Proof Print job list ( P.183), select the job that you want to delete, and then
press [DELETE].

Page 188: Private Print Jobs
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Private Print jobs Private Print refers to
the function to print a document from a computer on the network only when a set password is
keyed in to the equipment’s control panel. This function is useful when you want to print
confidential documents and prevent them from being seen by others.

Page 189 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL Enter the password for the Private Print job, which has previously
been set via the computer, and then press [OK]. The Private Print jobs are listed on the screen.
When the Private Print job is sent from a Windows computer: - When the user name that is
entered to log in to your computer is used for [User name (Alias)], the displayed list contains
the Private Print jobs for which the same password has been set.

Page 190 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Printing Private Print jobs
Follow the procedure below to release your Private Print jobs from the control panel. On the
Private Print job list ( P.186), select a job for printing. You can select more than one job.

Page 191 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL Deleting Private Print jobs Follow the procedure below to delete a
Private Print job. On the Private Print job list ( P.186), select the job that you want to delete, and
then press [DELETE].

Page 192: Hold Print Jobs
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Hold Print jobs Hold Print refers to the
function to retain a document from a computer on the network until a user performs printing
from the equipment’s touch panel. This function is useful to prevent you forgetting to remove
printed sheets. Hold Print jobs can be released or deleted from the Hold Print job list.

Page 193 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL On the Hold Print job list, select the desired user name. The
displayed list contains the Hold Print jobs stored in the Hold Print queue. When you enter the
nickname for [User name (Alias)] box on the [Others] tab on a Windows computer, and send the
job to the equipment, its nickname will be displayed on the Hold Print job list.

Page 194 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Printing Hold Print jobs
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Follow the procedure below to process your Hold Print jobs from the control panel. On the Hold
Print job list ( P.190), select a job for printing. You can select more than one job.

Page 195 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL Deleting Hold Print jobs Follow the procedure below to delete a
Hold Print job. On the Hold Print job list ( P.190), select the job that you want to delete, and then
press [DELETE].

Page 196: Invalid Jobs
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Invalid jobs An Invalid job refers to a job
being held due to an incorrect or no department code being entered for performing the job. If
the equipment is managed by the Department Management feature with the SNMP network
services disabled, entering an incorrect department code for printing from a computer on the
network causes the job to be held as an invalid job and stored in the Invalid job queue.

Page 197 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL Select [INVALID]. The Invalid jobs are listed on the screen. Printing
Invalid jobs If you have entered an incorrect department code for printing, you need to re-enter
the correct one. Follow the procedure below.

Page 198 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Press [PRINT]. Printing starts.
The job in progress can be monitored from the [JOBS] tab listing the Normal Print jobs ( P.178).
Deleting Invalid jobs Follow the procedure below to delete an Invalid job. On the Invalid job list (
P.194), select the job that you want to delete, and then press [DELETE].

Page 199: Printing Files From Usb Media (Usb Direct Printing)
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS FROM THE
CONTROL PANEL Printing files from USB media (USB Direct Printing) USB Direct Printing refers to
the printing of files saved in a USB storage device that is connected to the USB port on the
equipment.

Page 200 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Enter the department code
using the on-screen keyboard and digital keys, and then press [OK]. The above screen will not
be displayed when the equipment is not managed by department codes. Proceed to the next
step.

Page 201 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL In the list of files, select the file that you want to print. Select the
files you want to print from the list. If the target file is not displayed on the screen, use to
change between pages.

Page 202 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Using the on-screen
keyboard and the digital keys, enter the user or master password for the encrypted PDF file,
and then press [OK]. If the selected encrypted PDF file was created on Adobe Acrobat 6.0 or
later, enter the document open password or permissions password.

Page 203 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL Press [SETTINGS] and then select the setting items as required. To
print a JPEG file, you can set [SIZE]. To print a PDF file, you can set [FINISHING], [2-SIDED] and
[PDF Overprint]. 1) Press any of [SIZE], [FINISHING], [2-SIDED] and [PDF Overprint].

Page 204 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 2-SIDED Set 2-Sided Printing.
1 SIDE — Select this to print only one side. BOOK — Select this to print on both sides by setting
a vertical binding margin. Pages are turned over from right to left.

Page 205 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL Press [PRINT]. The equipment starts printing. The printouts are
directed to the receiving tray. The job in progress can be monitored from the [JOBS] tab listing
the Normal Print jobs. Before Disconnecting the USB Storage Device: Make sure that “USB
DEVICE in use.

Page 206: Viewing The Print Job Log
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Viewing the Print Job Log You can view the
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log of print jobs on the touch panel. Viewing the print job log On the touch panel, press [JOB
STATUS]. Press [LOG] to display the [LOG] tab. Viewing the Print Job Log...

Page 207 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL 5.MANAGING PRINT JOBS
FROM THE CONTROL PANEL Press [PRINT]. The Print Log is displayed. On the Print Log, each
job’s user name, date and time of the job, paper size, the number of pages and the number of
copies are displayed.

Page 208: Checking Supplies
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Checking Supplies Viewing the drawer
status When the equipment is idle, pressing [JOB STATUS] > [SUPPLY] displays the [SUPPLY]
tab. From this tab, you can view the paper size setting selected for each drawer. If you press
[SUPPLY] when printing is in progress, the drawer from which paper is being fed is highlighted.

Page 209: Other Printing Methods
OTHER PRINTING METHODS This equipment also supports the following printing methods: FTP
Printing .......................... 208 Email Printing ........................209...

Page 210: Ftp Printing
6 OTHER PRINTING METHODS FTP Printing FTP printing is available when the FTP print service is
enabled on this equipment. You can print a document by sending the print file to this equipment
using the FTP. This equipment can accept the following files for printing: PCL file PS file...

Page 211: Email Printing
6 OTHER PRINTING METHODS Email Printing Email printing is available when enabled on this
equipment. You can print a document by sending the print file, as an email attachment, to this
equipment using the mail client software. This equipment can accept only TIFF-FX (Profile S),
TIFF-FX (Profile F) and TIFF-FX (Profile J) files for printing: When the User Management setting is
enabled, a print job sent by Email is processed as an invalid job according to the User
Authentication Enforcement setting.

Page 213: Chapter 7 Appendix
APPENDIX This chapter provides the following contents. Internal Fonts List ........................ 212
Internal PCL fonts list ............................212 Internal PS fonts list............................213...

Page 214: Internal Fonts List
7 APPENDIX Internal Fonts List The following fonts are included in this equipment. Internal PCL
fonts list Courier Helvetica-BoldOblique CG-Times Helvetica-Narrow CG-Times Bold Helvetica-
Narrow-Bold CG-Times Italic Helvetica-Narrow-Oblique CG-Times Bold Italic Helvetica-Narrow-
BoldOblique CG Omega Palatino-Roman CG Omega Bold Palatino-Bold CG Omega Italic Palatino-
Italic CG Omega Bold Italic Palatino-BoldItalic...

Page 215: Internal Ps Fonts List
7 APPENDIX 7.APPENDIX Internal PS fonts list AlbertusMT-Light Eurostile-ExtendedTwo
AlbertusMT Eurostile-BoldExtendedTwo AlbertusMT-Italic Geneva AntiqueOlive-Roman GillSans-
Light AntiqueOlive-Italic GillSans-LightItalic AntiqueOlive-Bold GillSans AntiqueOlive-Compact
GillSans-Italic Apple-Chancery GillSans-Bold ArialMT GillSans-BoldItalic Arial-ItalicMT GillSans-
ExtraBold Arial-BoldMT GillSans-BoldCondensed Arial-BoldItalicMT GillSans-Condensed
AvantGarde-Book Goudy AvantGarde-BookOblique Goudy-Italic AvantGarde-Demi Goudy-Bold
AvantGarde-DemiOblique Goudy-BoldItalic Bodoni Goudy-ExtraBold Bodoni-Italic Helvetica...

Page 216 7 APPENDIX NewCenturySchlbk-Italic ZapfDingbats NewCenturySchlbk-Bold
IPAexGothic NewCenturySchlbk-BoldItalic IPAexMincho NewYork Optima Optima-Italic Optima-
Bold Optima-BoldItalic Oxford Palatino-Roman Palatino-Italic Palatino-Bold Palatino-BoldItalic
StempelGaramond-Roman StempelGaramond-Italic StempelGaramond-Bold StempelGaramond-
BoldItalic Symbol Taffy Times-Roman Times-Italic Times-Bold Times-BoldItalic
TimesNewRomanPSMT TimesNewRomanPS-ItalicMT TimesNewRomanPS-BoldMT
TimesNewRomanPS-BoldItalicMT Univers-Light Univers-LightOblique Univers Univers-Oblique
Univers-Bold Univers-BoldOblique Univers-Condensed Univers-CondensedOblique Internal Fonts
List...
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Page 217: Index
INDEX ............ 142 Numerics Destination folder ........125 Destination Paper Size ..........36 2-
Sided Printing ..........134 Destination profiles ............142 5-digit password ............... 52 Detail
........... 68 Device Settings Retrieval ........14 [Device Settings] tab ............. 30 A4 Tab ............37
Direction of Print ..........

Page 218 ............ 132 ............62 Image Type Output Devices ...............63 ........41 Import
Output Document Layout ..............127 ............73 In Printer Output Format ..............20
..........123 Initial values Output Options ..........44 .............. 73 Insert Pages Output PDL
............14 ..........56 Inserter Unit Overlay Image ..........

Page 219 ..............213 .............. 121 PS fonts Two-Sided ..............50 Pure Black ........132
Pure Black and Gray ..............50 ..............34 Pure Gray Units ............54 Update Now ..........197
USB Direct Printing ............126 ............. 197 Quartz Filter USB media ..........197 USB storage
device ..........44 Use Back Cover ..........

Page 220 INDEX...

Page 221 FC-5540C/6540C/6550C FC-2040C/2540C/3040C/3540C/4540C OME10005400...

Page 222 MULTIFUNCTIONAL DIGITAL SYSTEMS Printing Guide 2-17-2, HIGASHIGOTANDA,
SHINAGAWA-KU, TOKYO, 141-8664, JAPAN R100520J0200-TTEC 2011-03 ©2011 TOSHIBA TEC
CORPORATION All rights reserved...

This manual is also suitable for:

Estudio 6550cE-studio5540cE-studio6540cE-studio6550cE-studio2040cE-studio2540c ... Show all
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